
Program Description
Drag And File streamlines and simplifies the work of managing files under Windows 95 and Windows NT. 
It offers several unique functions, such as a directory finder, a duplicate file finder and a DOS command 
utility.
Drag And File works at several levels of sophistication and integrates with other management and utility 
programs. The result is an uncommon degree of flexibility: Drag And File can be configured to meet your 
needs, your working style, and your experience. When you need more, Drag And File delivers. 
Unlike most other Windows file managers, Drag And File allows you to highlight individual files and tag 
multiple files, which makes possible batch operations on non-contiguous groups of files. 
Drag And File offers a broad range of file management tools:

· Drag-and-drop file move, copy, and delete

· Viewing of all text and most graphics files

· Tree and branch batch operations on all files

· Single click execution of most frequent tasks from a toolbar, including viewing

· Separate windows for each drive

· Full configurable hot key control for hands-on keyboard    execution

· Formatting and diskcopying for floppy diskettes

· Full access to the Windows 95 Shell functions like creating shortcuts, Quick View and file 
properties.

Main window

Drag And File displays a window complete with toolbar and menu choices for each drive selected. You 
may open up to 12 drive windows simultaneously. 
The entire program can be run from a single small Drivebar which floats unobtrusively on your screen. 
The Drivebar makes complete directory and file information just a mouse click away.



Drivebar

Drag And File includes an Uninstaller to remove the program and changes made during installation. 

Note:    Microsoft Windows' file-handling requirements may make it necessary for you to delete the 
uninstaller file itself. 



User Help
Drag And File is designed to present options and procedures clearly. The window components, including 
icons, graphic and text buttons, and directory tree displays, make evident what to do and how to do it.
Along with ease of use and the ordinary features of file management, Drag And File offers an unusual 
degree of sophistication. 

Canyon Software is committed to producing software that is useful and productive. To help users make 
full use of Drag And File, Canyon Software maintains a technical help line for registered users from 8:30 
AM to 5:30 PM Pacific Time.

Phone (415) 453-9779
Fax (415) 453-6195
BBS (415) 453-4289
CompuServe Go CANYON
America On Line DanBCan
Internet danb@canyonsw.com



Options/Settings
From the Options menu you access the Fonts and Settings dialog boxes, which allow you to adjust 
several aspects of the program's performance and display.
To change fonts:

1. Select Fonts from the Options menu.

The Fonts dialog box displays. Available fonts are those which are installed under Windows, or 
under a type manager working with Windows.

Font options dialog box

2. Make whatever changes you wish and click OK.

The changes take effect immediately and remain when you exit the program.
To change Settings:

1. Select Settings from the Options menu.

The Settings dialog box displays.    The Settings dialog box has three pages for configuring Drag 
And File Options.    In addition if you have our programs Drag And Zip or Drag And View Gold 
installed, there will be pages for configuring them too.      You select a page by clicking the mouse 
on one of the tabs at the top.    The first page is for general settings.



General    Settings page

2. Enter your choices for warnings, multiple windows operations and window appearance, file delete 
and editor.

Overwrite Warnings. When enabled, these warnings appear when the files you are copying 
or moving are about to overwrite files of the same name.      These warnings can always be 
overridden at copy or move time.

File Delete. When checked, files deleted in Drag And File will be send to the RECYCLE BIN. 
When not checked, you will have to use an undelete program to recover deleted files.    This 
option may not work on earlier builds of Windows 95.    We know that it works on bulds 474 
and greater.    This option is not available when running under Windows NT.

Multiple Window Operations. Drag And File lets you perform operations on tagged files in 
more than one window. These choices allow you to specify which operations you would like to 
perform in multiple windows.

When Copy from multiple windows is checked, Drag And File will perform all file copy 
operations on the highlighted file or the tagged files from all open Drag And File windows.

When Move from multiple windows is checked, Drag And File will perform all file move 
operations on the highlighted file or the tagged files from all open Drag And File windows.

When View files from multiple windows is checked, and you choose the view files option 
from the Drag And File tool bar or the "Actions" menu, Drag And File will view the highlighted 
and tagged files from all open Drag And File windows.

When View directories from multiple windows is checked, and you choose the view 
directories option from the Drag And File tool bar or the "Actions" menu, Drag And File will 



open up a view window with the listing of all the files in the highlighted and tagged directories 
from all open Drag And File windows.

When Drag and drop from multiple windows is checked, all drag and drop operations to 
other programs include the tagged files or highlighted file from all Drag And File windows.    
Drag And Drop operations to toolbar buttons will depend on the configuration for the action of 
the particular button.    For example, if you have Drag And File configured to copy from only 
the active window, dragging files to the copy button will only work on the active window no 
matter what you have configured for drag and drop.

When Zip file from multiple windows is checked and you click on the zip button on the 
toolbar, the highlighted file or the tagged files in all the open Drag And File windows will be 
put in the resulting Zip file.

Window Appearance. These choices follow the pattern for Microsoft Windows: cascaded 
windows are overlapped slightly, and tiled windows are fully visible.

Editor.    Enter your editor of choice in this field and you can edit a highlighted file when you 
choose the edit file option.

 Drives Page

3. In the drives page you can configure the drives that are available to Drag And File.    This is 
particularly useful on networks where you might want to limit the drives available to different 
users.    The settings in this dialog box will be reflected in both Drag And File and the Drag And 
File Drive Bar.

Select the drives that you want to have available.    To make drive selection easier, there are 
check boxes where you can turn on or off the different drive types.    Drives that have been 
selected will be displayed below the drive list box.



DOS Command Page

4,    You can turn on Drag And File’s DOS Command Line by choosing Show DOS Command Line 
from the Options menu.    In this page you can set the DOS command Line defaults.

DOS In Window:    You can run most DOS commands with the SmilerShell and can choose to 
have these commands run full screen or in a DOS window.    The default is to run the commands 
in a DOS Window.

Inactive DOS Windows Stay Visible:    This options determines whether the DOS windows will 
stay around or close after DOS commands are run.    If you choose to have the DOS windows 
stay around you can easily close them all at once by pressing Ctrl+Shift+K from the keyboard.

Insert Mode: Use this to toggle between Insert or Overtype mode

Use Comspec: By default, the DOS command utility, will send all DOS commands to the 
standard DOS command processor, COMMAND.COM.    Some programs like 4DOS, NDOS and 
others use a different command processor.    They specify the command processor in your 
CONFIG.SYS file with the statement "comspec=".    If you choose to use the command processor 
specified in your CONFIG.SYS file, see that this item is checked.    Inorder to see this option take 
effect you will have to restart Drag And File.    This is only necessary with the Use Comspec 
option.



Configure Toolbar
Drag And File's button toolbar is very easily modified allowing you to add and delete different buttons.    
Programs can also be added to toolbar buttons.    All toolbar buttons can be configured to user Alt or Ctrl 
key combinations as hot keys.    Alt hot keys are shown in the lower right of the button as black on gray.    
Ctrl hot keys are shown as white on black.    There is also an option to completely hide the toolbar.    If the 
toolbar is hidden, the configured hot keys are still active.
To modify the toolbar:

1. Choose Customize Toolbar from the Options menu.

The Toolbar Customize dialog appears:

Toolbar Customize dialog

In the list box on the left appear the available button choices.    The top two entries are SEPARATOR 
and NEW PROGRAM.    SEPARATOR adds a space between two buttons.    NEW PROGRAM allows 
you to install a program as a button choice.    In the list box on the right appear the buttons that are 
currently part of the toolbar along with their hot keys. 

To add a new button

1 Select the position in the Toolbar buttons list box where you want the button to appear.    The new 
button will appear before the selected button.    You can also drag buttons in the Toolbar buttons 
list box to modify their position.

2. Select the button that you want to add from the Available buttons list box.    You can also choose 
SEPARATOR or NEW PROGRAM.    If a command button is already in the Toolbar buttons list 
box, it won't be in the Available buttons list.

3. Choose Add or drag the button to the right hand list box.    The button will be added.
To remove a button

1. Select the button that you want to remove from the Toolbar buttons list box.    Click on Remove or 
drag the button to the left hand list box.    The button will be removed.

To add a program

1. Select NEW PROGRAM and choose Add.    The Add Program dialog will appear.



Add Program dialog box

2. Browse through the directories and files and pick the program that you want to associate with the 
button.    If you want the file that's currently highlighted to be launched with the program check the 
Launch Highlighted File With Program box.    When the mouse cursor is over any of the toolbar 
buttons, a little window will come up saying what the button does.    You can enter a custom 
button description in the Button Description field.    If no description is entered, the program 
name will be used.

3. Choose OK and the button will be added to the Toolbar buttons list box.    If the program has an 
embedded icon like most Windows programs, that icon will be placed on the button.

To modify a program button

1. Highlight the button in the Toolbar buttons list box.    Choose the Program button and the Add 
Program dialog will appear.    Follow the directions for adding a program.

To add or change a button hot key

1. Highlight the button whose hot key you want to change or add.    Select the letter of the hot key 
that you want to use from the drop down list box in the lower right of the Customize Toolbar dialog 
box.    Choose Alt or Ctrl if you want the hot key to use the Alt key or the Ctrl key. 

When you are finished making changes to the toolbar, choose OK.    All changes will be saved and 
windows updated.    If you choose a hotkey that is already in use, you will be warned before saving the 
new hot key.



About the Drivebar
Though small and unobtrusive, the Drag And File Drivebar can provide access to all your Drag And File 
functions.
The Drivebar consists of a floating bar containing buttons which represent your drives, removable and 
fixed drives, local and networked, and a control bar. Click on a drive button to open a new drive window. 
Click on the control bar to open a menu with choices to control the Drivebar display and to close all open 
Drag And File windows.

Drivebar

The DF Drivebar normally floats in the foreground, above whatever application is current.



Using the Drivebar
To activate the Drivebar, open the Drag And File group window from Program Manager and click on the 
DF Drivebar icon. 

Drivebar icon



Configuring the Drivebar
The    Drivebar can be altered to fit your needs. 
To configure the Drivebar:

1. Click on the control bar in the upper left corner of the DF Drivebar icon bar.

The control menu appears.

Drivebar control menu

2. Click on Display Vertically (or Display Horizontally) to select the configuration other than the 
one currently in effect.

3. Click on Always Visible to make the Drivebar appear on top of other programs.

4. Click on Close All Drag And File Windows to close all open Drag And File drive windows, but 
leave the Drivebar icon visible.

5. Click on other choices as needed to Move, Close, open a Help window, or to see information 
about the Drivebar.



Drag And File Main Window
The Drag And File window is divided into several functional and information sections. Drag And File can 
open up to twelve windows simultaneously.

Drag And File main window

The menu bar contains drop down menus. They are accessible with a mouse or directly from the 
keyboard by using the Alt key in combination with the underlined letter or arrow keys.
The information sections contain data about the drive currently displayed, number of directories on this 
drive, the space remaining on the drive, the    files in the selected directory, and their total size.
The drive buttons allow you to choose which drive information the open window displays. Double clicking 
on the icon of the currently displayed drive opens a second window displaying that drive.
The lower half of the window is divided into two panes: information in the left pane concerns directories, 
and information about files appears in the right pane.



Choosing files and directories
Drag And File, slightly differently from Microsoft Windows File Manager,    and Windows 95 Explorer.

Drag And File marks files and directories by highlighting, tagging, and dotting.

· Highlight files and directories by left clicking on them with the mouse, or by using the arrow keys 
to move the highlight bar up or down over a listing. Only one directory or file can be highlighted at 
a time. Operations like Copy or Move can be performed on a highlighted file by clicking the 
appropriate tool, or by using drop down menus or keyboard shortcut keys. If any files are tagged, 
highlighting is ignored.

· Tag and untag files or directories by several methods:

· Ctrl+Left Mouse Button will tag or untag a file.    A tagged file has a red arrow to its left.

· Ctrl+Left Arrow or Slash tag all files or directories

· Right arrow to tag; left arrow to untag.    ( This method is not available when viewing filenames 
only )

· Spacebar and Ctrl-Right click to toggle tagging on or off.

· Ctrl+Right Arrow or Ctrl+Slash untag all files or directories

· Dots mark files which have been copied. Dotted files may be reselected as a group for other 
operations.



Menu Bar
The menu bar contains the headers for the main drop down menus. Most menus include information 
about shortcut key combinations to activate commands from the keyboard.
Drag And File includes in its menu bar extensions¾drop down menus inserted in the File Manager's menu 
bar by utility and other programs.



Drive bar
The drive bar includes buttons that represent all accessible drives.    Click on a drive button to change to 
that particular drive.    Double click on a drive button to open a new Drag And File window for that drive.    
Additionally, files can be dragged to the drive buttons for copying or moving.    In Windows 95 you can 
right click on a drive button to bring up a context menu. From this context menu you can access the 
drives sharing, format the drive, create a shortcut or access the drives properties.



Toolbar
The toolbar displays a series of buttons that activate tools or shortcuts.



Directory Pane
The directory pane displays, in a tree format, all directories and subdirectories of the currently selected 
drive.



File Pane
The file pane displays a list of the files and their attributes contained within the currently selected directory 
or subdirectory.    If you are viewing all file details (the default view) there will be a Caption Bar over the 
file listing.

You can drag the boarders of some of the sections to resize the colums.    When you click on the heading 
buttons you will sort the file list in the order of the button legend.    One click will sort ascending.    The 
second click will sort descending.



Type to File/Directory function
To locate a specific directory or file, when the appropriate pane is active, start typing the name of the 
directory or file. Your typing appears in a small window that opens over the directory count in the lower left 
corner of the window, beneath the directory pane. As you type, the highlight bar will move to the directory 
or file which most closely approximates your typing.



Drag and drop functions
Drag And File uses all the mouse conventions associated with Microsoft Windows programs.
When you drag and drop files and directories with the left mouse button to a directory or drive button, a 
dialog box opens. Using options in the dialog box you can specify a Copy or Move operation, the name of 
the file or directory, and use a browse feature to specify the path.
When "Drag and drop from multiple windows" is turned on in the settings dialog, all drag and drop 
operations will use the highlighted or tagged files in all open Drag And File windows.
Files or directories can also be dragged to toolbar buttons.

When you drag and drop files and directories with the right mouse button under Windows 95, a context 
menu will popup allowing you to copy or move the files or creeate a shortcut to the files. 



Toolbar functions
Drag And File's toolbar contains buttons which make the most common file management tasks easily 
accessible.    Functions and programs can be added to or deleted from the toolbar by choosing 
Options\Modify Toolbar.



Using The Keyboard
Drag And File allows you to access most functions directly from the keyboard as well as use the mouse to 
select functions from a drop down menu.    All buttons can have Alt or Ctrl key combinations assigned to 
them.



File Menu
Use commands in the File menu to perform the most common functions used to manage your files and 
directories.    If the command has a button associated with it, then this command can be put on the 
toolbar.



Copy Shortcut: F8

The copy command copies directories or files depending on which pane is active.
If you are copying a single file, the file may be renamed as part of a Copy operation, if you type the full 
pathname of the new file in the text field in the Copy/Move dialog box.    If you are copying more than one 
file and enter a path name that doesn't exist, Drag And File will assume that you want to create the new 
directory and give you the option to create it. 
The bottom of the Copy/Move dialog box contains additional options:

· Use the browse button to easily choose destination directory.

· Perform the operation on just the current window or multiple open windows.

· Turn on and off overwrite options.

· Change the copy operation to move and vice-versa.

· If the operation is being performed on a directory with branches, the operation can also be 
performed on the entire branch.



Move Shortcut: F7

The move command moves a file or directory depending on which pane is active.    All the options in the 
copy dialog also exist for Move



Delete Shortcut: Del

Use the Delete command to delete a single highlighted or one or more tagged files or directories. 
The dialog box which appears when you invoke this command is the only confirmation you will see of this 
operation.
In the more recent builds of Windows 95 (470) and later, the default is for deleted files to go to the 
Recycle Bin.    This can be changed by going into the “Options/Settings” dialog.



Rename

Use the rename command to rename a file or directory.    If multiple files are selected they can be 
renamed en masse with wild cards.



Edit Descriptions

Drag And File allows you to attach descriptions to files.    These descriptions will be maintained when files 
are copied, moved and deleted. Use this command to add or edit a file description.

Note: This option will not be available on the File menu unless View Descriptions is turned on.    The View 
Descriptions command    appears on the Options menu.

.Note: For more information on file descriptions, see the section Working With File Descriptions.



Launch Shortcut: Enter

Use the Launch command to launch the highlighted file.    If the highlighted file is a data file this command 
will run the associated program with the data file.    If the highlighted file is a program, then the program 
will be run.
If no association exists for the type of file you have selected, Drag And File opens a dialog box in which 
you may record an association for this type of file.



Make Directory

Use the Make Directory command to create a new directory as a subdirectory of the currently highlighted 
directory.



Find Files

The Find Files command searches for files in selected directories or drives.    If you wish to search for a 
file in selected directories, select the directories that you want to search.    You can do this in multiple Drag 
And File windows.    Then choose "Find" and enter the filename that you want to search for. Wild cards 
are permitted.    Alternately, you can also choose to search for the file in the current drive or multiple 
drives.

The find dialog allows you to search for files for files that certain text or match a particular file attribute or 
both.



File Attributes Shortcut: Alt+Enter

Use the File Attributes command to open the Attributes dialog box.

File attributes dialog box

Use choices in this box to assign or remove attributes which are useful in managing files, and which the 
operating system sometimes assigns    automatically. MS-DOSâ uses four attributes and a null condition:

· Archive

· Read Only

· System

· Hidden

· No Attribute
The Archive attribute is assigned by DOS to a file which has changed after being backed up.
Read-only prevents a file from being edited or deleted.
System files, designated by DOS, contain information about hardware and system configuration. They 
cannot normally be deleted or changed.
Hidden prevents a file from being included in a DOS directory listing. Drag and File, however, does 
include hidden files in its display of files in a directory. 
Files with no attribute options checked are considered Normal Attribute.



Associate
Use the Associate command to associate a program file with a file of a particular type identified by its 
three-letter extension.
For example, files ending in .TXT are normally text files and would be associated with an editor such as 
Windows Notepad or Norton's Desktop Editor.
To record an association:

1. Click on the Associate option from the File menu.

2. Choose the program file from those displayed.

-OR-

Click on Browse to select a program file from another directory.

3. Click OK to close the window and record your choices.



Multi Associate
Use the Multi Associate command to associate more than one program with filenames of a specified 
extension. If you want to choose among different word processors to edit files with a .TXT extension, for 
example, you would use this command to list those word processors.
When you double click on a file with such an extension, Drag And File opens a dialog box which allows 
you to choose one of the designated programs associated with this filename extension.
To record multiple associations:

1. Click on the Multi Associate option from the File menu.

2. Type the full pathname (including drive, directory, and filename) of the new program.

-OR-

Click on Browse to select a program file from another directory.

3. Click Add to add the program to those displayed in the current associations window.

4. Click OK to close the window and record your choices.



List All Files Shortcut: Ctrl+Enter
Use the List All Files command to open a files-only window which contains an alpha-ordered list of all files 
on the drives you select.
To list all files:

1. Select this command to open the drive selection window.

2. Select the drives containing the files you wish to list. 

A click of the left button of the mouse toggles drive selection.

3. Click OK to open the file list window.



Exit

Use the Exit command to close a Drag And File window.



Close All Drag And File Windows

Use this command to close all open Drag And File windows, including the window from which the 
command was selected. 
The DF Drivebar is not affected by this command.



Format Diskette

Use this command to format a floppy diskette. The contents of the diskette will be destroyed.    You can 
prevent this by choosing the option "Safe Format".

Format Diskette Dialog Box

The options are:

· Make Disk Bootable.    Use this option if you want to be able to start your computer from this disk.

· Quick Format.    Use this option on a diskette that has already been formatted.    This option will 
re-write the boot sector and root directory but will not reformat the diskette.

· Safe Format:    Use this option to save any existing files on the diskette.      This allows you to 
refresh the formatting of a diskette without having to destroy all the files on it.



Map Network Drive

This option will only be available when you are connected to a network. Choosing this option will bring up 
a dialog box allowing you to choose network drives to connect to.



Disconnect Network Drive

This option will only be available when you are connected to a network. Choosing this option will bring up 
a dialog box allowing you to disconnect from any connected network drives.



Network Neighborhood

This option will only be available when you are connected to a network. Choosing this option will bring up 
a the Windows 95 Network Neighborhood Window



Sort by Extension Shortcut: Ctrl+Shift+E

The by Extension command sorts files by the three-letter filename extension, in alpha order of extension, 
and by alpha order within each group of files of the same extension.    Options are available to sort in 
ascending or descending order.    Sorting by extension can also be done by clicking on “Type” on the 
heading bar.



Sort by Filename Shortcut: Ctrl+Shift+F

The by Filename command sorts the file list by filename in alpha order. Options are available to sort in 
ascending or descending order.    Sorting by filenmane can also be done by clicking on “Name” on the 
heading bar.



Sort by Date Shortcut: Ctrl+Shift+D

The by Date command sorts the file list in order of date.    Options are available to sort in ascending or 
descending order.    Sorting by date can also be done by clicking on “Modified” on the heading bar.



Sort by Size Shortcut: Ctrl+Shift+S

The by Size command sorts the file list by size.    Options are available to sort in ascending or descending 
order.    Sorting by sizecan also be done by clicking on “Size” on the heading bar.



Unsorted Shortcut: Ctrl+Shift+U
The Unsorted command resets the file list to the original order before other sort commands were applied.



Save
The Save command saves the current sort order as the default.



Expand One Level Shortcut: Num Pad Plus
Use this command to expand the highlighted directory tree one level.    Only a tree with a "+" on it has sub 
directories and can be expanded.



Expand Branch Shortcut: Num Pad Star
Use this command to expand the highlighted directory tree and show all of its sub directories.    Only a 
tree with a "+" on it has sub directories and can be expanded in this way.



Expand All Shortcut: Ctrl+Num Pad Star
Use this command to expand the entire directory tree so that all the sub directories are showing.



Collapse Branch Shortcut: Num Pad Minus
Use this command to collapse an expanded directory branch.    An expanded directory branch has a "-" on 
it.



Collapse All Shortcut: Ctrl+Num Pad Minus
Use this command to collapse the entire directory tree and show only the root directory.



Fonts

Use the Fonts command to open the Font selection dialog box. This allows you to choose one of the 
Windows installed fonts to use for directory and file listings.



Settings
Use the Settings command to open the Settings dialog box. Choices in this dialog box allow you to: 

· manage overwrite warnings 

· enable operations on multiple windows 

· specify how files are deleted

· specify a text editor.

Note: For more information on changing Drag And File's settings see the section titled Setting 
Preferences.



Customize Toolbar
The toolbar in Drag And File is completely customizable.    You can add or remove over 30 different 
commands, specify any Ctrl or Alt key combination as a hot key and add any program to a toolbar button.

Note: For more information on customizing Drag And File's toolbar see the section titled Setting 
Preferences.



View All Details

Use this setting to have Drag And File show the file name, date, time, size and attributes as part of the file 
listing.



View Filenames Only

Use this setting to have Drag And File show only the file name in the file listing.



View Descriptions

Drag And File allows you to attach descriptions to files.    These descriptions will be maintained when files 
are copied, moved and deleted. Use this command to turn on the display of the file descriptions.
When viewing all details, descriptions will be shown on a second line under the file details listing.

Note: For more information on file descriptions, see the section Working With File Descriptions.



Show File Icons
Drag And File can optionally display the icon associated with a file.    The icon will be displayed right 
before the filename.    Use this command to turn this option on or off.



Show Toolbar
Use this command to turn on and off the display of Drag And File's toolbar.    Any configured hot keys will 
still be active even when the toolbar isn't displayed.



Show DOS Command Line
Drag And File comes with a licensed copy of    SmilerShell the very powerful DOS command utility.    
When this option is turned on, there will be an edit field at the bottom of all Drag And File windows.    Any 
DOS command can be entered in the window.

The default for this window is insert but pressing the insert key will toggle on overstrike mode.    All DOS 
commands will be run in a window and will close when the command is finished.    If you wish to keep 
these DOS windows open when the command is finished, place an asterisk before the command.    For 
example, if you type DIR and you want the window to be kept open after DOS finishes displaying the 
directory, enter "*DIR".



Recycle Bin

Use this option to open the Recycle Bin folder.    You can drag files to this folder to delte them or undelete 
deleted files



My Computer

Use this option to open up the My Computer folder.



Control Panel

Use this option to open up the Control Panel folder.



Filter

Use the Filter command to open a file specification dialog box. This allows you to specify the name, types, 
and attributes of files to appear in the file window.



View

The actions performed by this command depends on what Drag And File window is active.    If the 
directory pane is active, Drag And File will open a window showing the files in the selected directories.    If 
no directories are tagged, then Drag And File will will open a window with the files from the current 
directory.

When the file pane is active, Drag And File will try to open a window viewing the selected files.    If Canyon 
Software’s Drag And View Gold can be found, then Drag And File will run it and have it view the selected 
files.    If Drag And View Gold cannot be found, and the platform you are running under has a Quick View 
program.    Then Drag And File will run that program.



Compress

If Canyon Software’s Drag And Zip program is available, you can use this command to run it and 
compress the selected files.



Print Dir List / Print File List

Use the appropriate Print command to print a list of either the directory window or the file window.



Edit File

The Edit command allows you to activate the text editor specified in the Options/Settings dialog box and 
load the highlighted file into the editor.



Tag Shortcut: Right Arrow
The Tag command tags with a red arrowhead the file or directory currently highlighted.



Untag Shortcut: Left Arrow
The Untag command untags the tagged file or directory currently highlighted.



Tag All Shortcut: Ctrl+Left Arrow
The Tag All command tags all entries in the currently active window, directory or file.



Untag All Shortcut: Ctrl+Left Arrow
The Untag All command untags all tagged files or directories in the currently active window.



Tag Branch Shortcut: Ctrl+Shift+B
The Tag Branch command tags a selected directory and all of its branches.



Tag Files Shortcut: Ctrl+Shift+L

The Tag Files command opens a File specification dialog box, which allows you to specify the name, 
types, and attributes of files to be tagged.

Tag files dialog box



Retag Shortcut: Ctrl+Shift+R
The Retag command resets dots to tags. 
After a tagged group of files has been copied, the tag changes to a small red dot. Use this command to 
reset the red dot back to a tag, making possible additional actions on these files as a group. 

Note: Tagging and untagging is normally faster using the hotkeys or the mouse directly, rather than using 
a drop down menu, which adds an extra step to the process.



New Window

Use the New Window command to open a new Drag And File window.    The drive displayed in the current 
window appears in the new window. 



Cascade Shortcut: Shift+F5

Use the Cascade command to arrange the open Drag And File windows on the screen in an overlapping 
manner so the title bars are visible.



Tile Horizontally Shortcut: Ctrl+Shift+F4

Use the Tile Horizontally command to arrange the open Drag And File windows on the screen so that 
each is wholly visible. This command will tile them horizontally.



Tile Vertically Shortcut: Shift+F4

Use the Tile Vertically command to arrange the open Drag And File windows on the screen so that each is 
wholly visible. This command will tile them vertically.



Refresh Drive Shortcut: F5

Use the Refresh drive command to update the listing of directories in the left pane of the window.



Refresh Files Shortcut: F4
Use the Refresh files command to update the listing of files in the right pane of the window.



Working From Multiple Windows
Drag And File allows you to perform operations on files in more than one Drag And File window in a single 
operation.    These options are all off by default but they can easily be turned on from the Options/Settings 
dialog box.    The operations that you can perform from multiple windows are:

· Copy

· Move

· View Files or Directories

· Compress Files

· Drag And Drop Files or Directories
When any of these operations are turned on the operation will be performed on the tagged or highlighted 
files in all the open Drag And File windows.    As a safety measure, if a copying or moving operation 
results on writing a file on top of itself, the action will not be performed.
Drag and drop from multiple windows will only work when dragging the files or directories to another 
application like Drag And View Gold or Drag And Zip.    If the files are dragged to a toolbar command, 
Drag And File will use the configuration for the command rather than drag and drop.    For example, if you 
have drag and drop from multiple windows turned on but copying from multiple windows turned off and 
you drag files to the copy button, copying will only be performed on the active Drag And File window.



Drag And File Secondary Window
Besides the main Drag And File windows, Drag And File allows you to work with files from more than one 
directory or drive through the Drag And File secondary window.



Viewing Files in Tagged Directories
 The simplest way to bring up the Drag And File secondary window is to tag a number of directories and 
while still keeping the focus on the directory pane, click on the view button.    The files from the tagged 
directories will be read and listed in the secondary window.    If you turned on view directories from 
multiple windows, you can do this from more than one Drag And File main window.

Drag And File Secondary Window

The listing in the secondary window is very similar to the listing in the main window but listed after the file 
details is the full pathname for each file.    All copy, move, delete, view, compress, drag and drop 
operations can be performed on the files in the secondary window. 
Two options that the secondary window has that the main window doesn't have is sorting the files by path 
and displaying just the duplicate files.
By default, there is a Dupes button on the secondary window toolbar.    Clicking on this button will display 
only the duplicate files in the listing.    The legend in the lower left of the window will say Duplicate Files.    
Clicking on the Dupes button again will redisplay all the files.    The legend on the lower left will then 
display All Files.



Listing All Files
The list all files command also displays the files in the secondary window.    Choosing List All Files will 
bring up the following dialog box:

List All Files dialog box

From the dialog box you can choose the drives that you want to view.    The option to toggle on the display 
of just duplicate files is also available with this command.



Find Files
When you search for files Drag And File will use the secondary window to display the file listing.



Adding and Viewing File Descriptions
Drag And File allows you to add descriptions to files.    You turn on this option by choosing View 
Descriptions from the Options menu.    This will change the file listing to just show the filename and the 
description.    Descriptions can be added or modified by choosing Edit Descriptions from the File menu.    
You can also modify the description of a file when you choose rename.    Descriptions are saved in 4DOS 
DESCRIPT.ION files making them compatible with 4DOS and NDOS descriptions. 

Note: Descriptions will be maintained only when View Descriptions is turned on.    Because of the 
overhead in updating all the descriptions it is not possible to maintain the description files in the Drag And 
File secondary window



Using the Built-In DOS Command Line
We have licensed a copy of of the powerfull command line utility SmilerShell for Drag And File.    You can 
turn on the display of SmilerShell by checking "Show DOS Command Line" on the "Options" menu.    
When active, SmilerShell will appear as an edit window on the bottom of Drag And File.

SmilerShell supports command history, editing, and search.    It supports clipboard functions (cut, copy, 
paste) when given from the keyboard with the usual commands.    It can run DOS or Windows programs, 
and all    DOS internal commands

SmilerShell saves it settings under the [SmilerShell Params] heading in DRAGFILE.INI.    You can find this 
file in your Windows directory.

Command History and Search: Every time you run a command, it is saved on the command stack.    To 
find a previous command of interest, type the first letter or two of that command, then press the up or 
down arrow key.    Up-arrow searches back, down-arrow searches forward.    It's a circular buffer, the last 
command is followed by the first, so you can search in either direction.    You can load a command stack 
automatically at startup.    This gives you a preloaded batch of commands you can search on.    A full 
command history list is available by entering the built-in HISTORY command.

Command Line Editor: A retrieved previous command, or anything else you type, can be edited to suit.    
Think of SmilerShell as a one-line word processor.    It supports insert mode, overtype mode, and 
clipboard cut/paste.

Drag And Drop: You can drop files into SmilerShell from any Drag And Drop server.    Their names will 
appear at the end of the command line.

Multiple Commands On One Line: You can type multiple commands on one command line.    Hit Enter 
and they are submitted in order.    By default these commands are separated by a caret [^].    Use the ini 
file parameter multicmdchar= to select any other character you want.

Aliases: When you press ENTER, the first word of the command is compared to the alias list.    If it 
matches, the alias is substituted for that first word.    You can skip the alias testing by starting the 
command with an equals sign (for example =dir).    Use the built-in ALIAS and UNALIAS commands to 
create, list, change, or remove aliases.

Runtime Parameters In Aliases: Runtime parameters (%1, %2, etc.) make it easier to tell aliases what to 
do when you run them.    And if you alias multiple commands on one line, the alias acts almost like a 
batch file, all within SmilerShell!

Quick Directory Change: Type DC and the first few letters of the directory you want to be in.    If 
unambiguous, boom, you're there, otherwise a list box pops up with the first possible match highlighted.    
If you haven't used DC yet, you'll be asked for permission to scan the drives listed in the DC ini file 
parameter.    If you've scanned more than one drive,    DC changes drive as well as directory if necessary 
to get you where you want to go.

DOS In A Window: Do you prefer to have DOS commands run fullscreen or in a window?    To toggle this, 
start the command with a right-bracket (for example >dir *.exe).

Inactives Stay Visible:    After you run a DOS command, do you want the command's inactive window to 
stick around or immediately vanish?    To toggle this, start that command with an asterisk (for example 
*copy foo.bat b:).

Remove Inactives: Too many inactive windows cluttering your screen?    Get rid of 'em all at once, from 



the keyboard.    The calling application's documentation gives the key to press (usually Ctrl+K).

File Associations: With File Associations, type in the filename without the program name.    Often 
SmilerShell will know which program to run.    For example give “FILENAME.WRI” and SmilerShell knows 
to run Windows Write on this file. 

What Happens When You Start SmilerShell Pro DLL
When you start SmilerShell, it first reads its initialization file.    (The calling application’s documentation 
probably lists the name and location of this file.)    Values are set, based on your entries in this file.    If you 
start SmilerShell without an initialization file, you'll be asked if you'd like SmilerShell to create one and fill 
it with reasonable values, then let you edit it in Notepad before proceeding.

Next, SmilerShell looks for DC information.    It will rescan your directory structure if you've set the ini file 
parameter startupDCscan=TRUE.    If not, SmilerShell looks for the file it created when you used DC to 
create or rescan this information.    By default the file is “smishell.dir” and is in the same directory as the 
initialization file.    You can specify a different name and directory for it by using the dirfile= ini file 
parameter. 

Then SmilerShell gets the current PATH from DOS.    It uses this to run your commands.    If necessary, 
you can change SmilerShell's copy of the PATH. 

If you have set saveparams to TRUE in the initialization file, SmilerShell sets itself up the way you left it 
last time, and changes to the directory you were in when you last used it.

Submitting Commands
When SmilerShell has the input focus, simply type any command, just as you would at the DOS prompt.    
You can run Windows or DOS programs, or DOS internal commands like DIR or TYPE.    You can use CD 
or CHDIR to change SmilerShell's current directory.    (Or you can change directory a lot faster with the 
built-in SmilerShell command DC.)    Overtype (usually Alt+O; consult your calling program’s 
documentation) toggles the command line between insert mode and overtype mode.

You can use the built-in SmilerShell commands ALIAS and UNALIAS (list, create, change, or remove 
aliases),    DC (quick directory change), HISTORY (full command history list), and SHOW (display 
filenames and select one into the command line).    To bypass the built-in commands (perhaps you have a 
program called DC?) start the command with an equals sign.

SmilerShell supports "drag and drop," so you can drop files onto its window from File Manager or any 
other drag-and-drop server.    The filenames will be added at the end of the current command line.    This 
lets you enter a program name in SmilerShell, and select the program’s filename parameters in File 
Manager.    SmilerShell adds the dropped filenames in the form that takes up the least amount of space 
on the command line.    For example, files in the current directory will have a filename but no path. 

Because SmilerShell supports File Associations, often you only have to give the filename, without naming 
the program to run it.    SmilerShell can in these cases tell what program to run, just by looking at the 
filename.      For example give “FILENAME.WRI” and SmilerShell knows to run Windows Write on this file. 
This works very nicely with SHOW: use SHOW to pick a file, then just press Enter to run the proper 
program with that file.

DOS commands called from SmilerShell will run fullscreen or in a desktop window, depending on how 
you have set DOS In Window.    Or you can start a command with a right-bracket to toggle DOS In 
Window for this one command (for example >copy foo.bat b:).

If you have toggled Inactives Stay Visible to allow it, then after SmilerShell runs a submitted DOS 
command, the final results are displayed in an inactive window.    That is, a window titled “[Inactive 
SOMETHING]” in Windows NT or “Finished - SOMETHING” in Windows 95.



When an “[Inactive...” (or “Finished”) window gets the focus as a result of running a command, 
SmilerShell actively takes the focus back again, so you can continue running commands from 
SmilerShell.    Because Windows requires it, SmilerShell pauses briefly before attempting to take back the 
focus.    By default this pause is 1000 milliseconds (1 second), but you can set it using the ini file 
parameter restoretime= .    How fast can your system get away with?

You can use the Remove Inactives keystroke sequence (usually Ctrl+K) to destroy all the inactive 
windows on your desktop.    Or you can start a command with an asterisk (for example you could type 
*dir) to toggle Inactives Stay Visible for just this one command.

Every command you submit is tested to see if it matches any of your aliases.    If the first word of your 
command matches an alias, the replacement for that alias is substituted for the first word of the command 
you typed.    Or to skip alias testing for this one command, start it with a equals sign (for example =list).    
The command line will be run just as you typed it.

An easy way to remember what each of the three command line flags does is:

* Flash! It's gone! (or, Flash!    A window appears!)
> Moves from larger to smaller, or smaller to larger
= Does just what it says (no alias or internal command substitution)

The three flags (* >    =) can be in any order.    For example, “>*=dir *.exe” could be run.

You can type multiple commands on one command line.    Hit Enter and they are submitted in order. The 
next command is submitted only after the previous one completes.

By default these multiple commands are separated with a caret [^] but you can use the ini file parameter 
multicmdchar= to select any other character you want.    For example, you could run this:

d: ^ cd \dos ^ *dir *.exe /w ^ dc fle ^ >myprog param1 param2 param3

which would change drive, change directory, do a DIR, change directory again, and run a program.

The three command line flags can be used with any of the individual commands.      Since each command 
is separate, each can have its own flags.    Aliases and parameters can be used in the usual way in each 
individual command.

When SmilerShell finds a PIF (Program Information File) for any program, it uses the PIF’s Inactives Stay 
Visible and DOS In Window settings instead of its own, assuming that if you set up a PIF you did so for a 
reason.    These days some DOS programs come with a Windows PIF.    Look for one if SmilerShell’s 
Inactives Stay Visible and DOS In Window settings don’t seem to work correctly.

By default, SmilerShell uses the command processor listed in the COMSPEC environment variable.    This 
is usually DOS’s COMMAND.COM, but some people use alternate processors such as 4DOS or NDOS. 
Sometimes the alternate processor has its own PIF file, for example 4DOS.COM may have a 4DOS.PIF 
file.    This PIF will prevent SmilerShell from controlling the Inactives Stay Visible and DOS In Window 
settings itself, since SmilerShell will defer to the settings given in the PIF.      To change this, either delete 
the PIF or set UseComspec=FALSE so SmilerShell will explicitly use COMMAND.COM, which it can 
control via "_default.pif."

As mentioned above, SmilerShell recognizes all standard DOS internal commands, such as DIR, COPY, 
or REN.    However, SmilerShell needs your help to know how to run the extended set of internal 
commands used by alternate command processors such as 4DOS.

To tell SmilerShell how to handle extended internal commands, set up a SmilerShell alias for any 
command you want to be recognized.    For example, to use FREE, set up this alias:



 
free=4DOS /C free

 
If you have renamed 4DOS.COM to COMMAND.COM you’d use this SmilerShell alias:

free=COMMAND /C free
 
Set up similar aliases for your other extended internal commands to explicitly call the command processor 
to execute them.    You can also use the 4DOS /C (or COMMAND /C) format right from SmilerShell’s 
command line to run any extended internal command.

Using Arrows To Retrieve Previous Commands
When you submit a command by pressing Enter, SmilerShell stores it internally in a command stack.    To 
retrieve a command, press the up/down arrow keys until the command you seek is displayed.    Press the 
up-arrow to see the previous command, or the down-arrow to see the next command.

You can search for a particular previous command to be displayed.    For example, let's say that you 
wanted to find the command “dir \windows\system\*.ini /p” that you ran before.    Just type D and press the 
up-arrow.    SmilerShell will find the most recent command that started with D.    You are not limited to just 
the first letter; you can type as much of the previous command as you need to specify the match you 
want.    If the first match isn't the command you are looking for, press that arrow key again until the 
command you want comes up.    The same match-string is used until you type something that changes a 
displayed command.    Matches are not case-sensitive.    The command-line flags (* > =) are ignored when 
checking for a match.

To simply retrieve all commands in order, just make sure the command line is blank when you first press 
the arrow key.    You can clear the command line by pressing Escape.

You can also use the built-in History command or the File menu's Command History item to gain access 
to your entire command history. 

Editing Commands
The normal editing keys allow you to move within the command line.    Use Home, End, left-arrow and 
right-arrow to move within the command line.    Ctrl+left-arrow move one word to the left, and Ctrl+right-
arrow move one word to the right.    You can clear the command line by pressing Escape.

SmilerShell's command line can be in either insert mode or overtype mode.    Toggle this from the calling 
application’s menu, if provided there, or with the supplied keyboard command (usually Alt+O).

Getting Rid Of Inactive Windows
If you have toggled Inactives Stay Visible to allow it, each DOS command ends by firing up its own 
“[Inactive...” window (or “Finished” window in Windows 95).    This is handy, letting you see the results of 
previous commands, but it does eventually clutter your screen.    To make them all go away, use the 
Remove Inactives keyboard command (usually Ctrl+K).

To toggle Inactives Stay Visible for just this one command, start the command line with an asterisk (for 
example *dir). You can use this with the equals or right-bracket flags if you want to (ex: =*>dir).

DOS Commands: Fullscreen or Windowed
DOS In Window controls whether active DOS commands called from SmilerShell run fullscreen or in a 
window.



To toggle DOS In Window for just one command, start the command line with a right-bracket (for example 
>dir).    You can use this with the equals or asterisk flags if you want to (ex: =*>dir).

About Internal DOS Commands
SmilerShell runs most DOS commands in a subshell.    For internal DOS commands that affect the 
working environment, this is tricky.    The subshell starts up with a copy of the parent's environment, things 
like current directory, environment variables, settable DOS version, etc.    If you alter an environment 
variable or change directory in a subshell, the parent shell's information does not change.    SmilerShell 
can support all the internal DOS commands you're likely to want.    It supports CD/CHDIR by itself (see 
below), and for the rest calls the system's command processor.    In addition, there are four “semi-
supported” internal DOS commands: CHCP, PATH, SET, and VER.    In DOS, these can both set and 
show environment values.    If you enter one of these, SmilerShell will show their current value.    However, 
because you are in a subshell, not your actual environment, you can't change these values in your actual 
working area through SmilerShell (or through Windows generally).

For CD/CHDIR SmilerShell changes the current directory on the specified drive, or its own current 
directory if no drive letter is given (that is, it acts just like DOS), and tells the calling application its new 
current directory.    CD or CHDIR with no parameter shows the current directory, handy when the title bar 
is toggled off.    To summarize:

Supported Commands: CD, CHDIR, COPY, DATE, DEL, DIR, ERASE, MD, MKDIR,    REN, RENAME, 
RD, RMDIR, TIME, TYPE, VOL

“ Semi-supported” Commands: CHCP, PATH, SET, VER

Unsupported Commands: CLS, CTTY, EXIT, PROMPT, VERIFY and the batch file commands.

Aliases
An alias is a short command that is replaced with a longer command.    Some people call them macros.    
When you type a (typically, short) command line and press Enter, the first word of the line is replaced with 
another (typically, long) string.    The rest of the original command line is tacked on after the replacement 
string.    You can define up to about 100 aliases.

You can list all current aliases with the built-in command ALIAS.    To display a particular alias, give the 
command ALIAS anAlias.    To create or change an alias, give the command ALIAS 
anAlias=itsReplacement.    To remove an alias, give the command UNALIAS anAlias, or ALIAS anAlias= 
(equals but no replacement).    The section on the built-in commands ALIAS and UNALIAS explains this in 
more detail.    For now, let's look at aliases themselves, and see what you can do with them.

Say you set up the alias:

dirprog=dir c:\develop\source\*.*

Whenever you enter the command “dirprog”, SmilerShell will replace it with, and actually submit, the 
command “dir c:\develop\source\*.*” to be run.    This saves wear and tear on your typing fingers.

Aliases can have static parameters.    In our example, you could enter “dirprog /o /p” and SmilerShell 
would run “dir c:\develop\source\*.* /o /p” by adding the original parameters after the substituted alias.    A 
typed alias is used just like any other command; type it in (with parameters if any) and press Enter. 

Unless you tell it otherwise, SmilerShell looks at the first word on each command line to see if it's an alias. 
To avoid alias checking for a particular command, start it with an equals sign.    For example, if you 
actually had a program called “dirprog” that you wanted to run instead of the alias defined above, you 
could submit this:



=dirprog

Because the command line starts with an equals sign, SmilerShell skips the alias testing for this 
command.

You can use the equals sign flag with the right-bracket or asterisk flags if you want to.    In this example, 
you could type >*=dirprog and press Enter.

SmilerShell Pro allows multiple commands on one line.    You can alias such multi-command lines.    For 
example:

bigcmd = cd \dos ^ *dir *.exe /w ^ dc fle ^ >=myprog param1 param2 param3

Notice the use of    equals, right-bracket, and asterisk flags on the multi-command line.    Since each 
command is separate, each can have its own flags.

Aliases can have runtime parameters %0 through %9, similar to DOS batch file parameters.    %0 is the 
alias-part itself, and %1-9 are the first nine arguments.    Here's a simple example that changes a file’s 
extension from ASC to anything else:

newextn=ren %1.asc %1.%2

To change filename.asc to filename.txt you'd use it like this:

newextn filename txt

Runtime parameters really shine in multi-command aliases.    For example, to implement your own “move” 
(copy and delete) command you could do this:

move=copy %1 %2 ^ del %1

Now, to move a file or group of files, you could give the command “move *.exe b:” and SmilerShell would 
copy the files, then delete the originals.

Any command line arguments that are not used up by % parameters are left at the end of the command 
line.    So “move *.exe b: fee foo” would turn into “copy *.exe b: ^ del *.exe fee foo”.

How about an alias like “move=copy %1 %3 ^ del %1” that doesn't use an argument? If you wrote an 
alias to use %1 and %3 but never refer to %2, the first and third argument would be used in the 
command, and the second argument would be put at the end of the command line.

Built-In SmilerShell Commands
SmilerShell includes a number of built-in commands.    To run them, just type their name and parameters 
from the command line.    You can bypass a built-in command if necessary by starting it with an equals 
sign, just like you'd bypass an alias.    For example, if you have some other program called DC that you'd 
like to run, you can bypass the built-in DC by starting the command line with an equals sign (=dc).    The 
equals flag can be used with the other two flags, and the three flags (* >    =) can be in any order at the 
beginning of the line.

ALIAS and UNALIAS: List, Create, Change, or Remove Aliases
The ALIAS command can list, create, change, or remove type-in or function-key aliases.    To learn what 
aliases can do, and how to construct them, see the Aliases section of this manual.

ALIAS (with no parameters) lists your aliases.    You can run an aliased command from this dialog box by 
clicking on it, or fetch the replacement-part into the main window for editing.



To add an alias to the list, or change an existing alias, use this form:

ALIAS theAlias= whatever replacement you want to run when you enter theAlias

To see what a particular alias will be replaced with, give an alias with no equals sign.

ALIAS anAlias

To delete an alias, use an equals sign but no replacement:

ALIAS anAlias=

The UNALIAS command can also delete an alias:

UNALIAS anAlias

In all these cases, you'll be asked if you want the changed alias information to be effective for only the 
current session, or saved permanently to the ini file.

DC: Directory Change The Fast Way
DC (Directory Change) lets you change directory very quickly.    Instead of having to type in the entire 
pathname, you only need to give it the first few letters of the endpoint (leaf-node) directory you want.    For 
example, instead of typing “cd \c8\mfc\samples\fileview” you could type “dc fi” and press Enter.    If “fi” is 
enough to unambiguously specify one directory, DC takes you right there.    If what you typed is 
ambiguous (maybe there's more than one directory whose name starts with “fi”) a window pops up, 
showing all your possible matches in alphabetical order.    The first possible match is highlighted.    If there 
was no possible match, nothing is highlighted.    Double-click on your choice, or single-click and press OK. 
At the top of the box is the number of directories DC knows about.    There's a button to re-scan the list as 
well.

To re-scan the list and change directory all at once, use the /r parameter.    For example “dc /r fi” would 
first re-scan, and only then look for that “fi” directory (in the new list) as described above. You can use a 
dash (“-r” instead of “/r”) if you prefer.

If the endpoint directory is on a different drive, DC will first change drives, then change to the desired 
directory.    There's no need for you to manually change drives first.    DC does it for you.

By default, the DC data is stored in the file “smishell.dir” in the same directory as the initialization file (or 
you can specify a name and location for this file with the ini file parameter dirfile=).    SmilerShell creates 
this file the first time you use DC (with your permission), or whenever you use the /r parameter.    It 
contains the name of every directory on each drive that was scanned.    These are the directories that DC 
can change to.    To indicate what drives you want scanned, set the ini parameter scandrives=.    For 
example, if this is in your DRAGFILE.INI file under the [SmilerShell Params]:

scandrives=cdm

then SmilerShell will generate a list of all directories on your c, d, and m drives.    (The list of drives can be 
separated by commas or spaces [scandrives = c, d, m], or bunched together as in the example above.    
SmilerShell simply ignores non-letters.)

If your system’s directory layout is constantly in flux, you may want to set the ini file parameter 
startupDCscan=TRUE so SmilerShell rescans your DC information every time it starts.

HISTORY: Display The History List
Type HISTORY to display the complete command history for this session, including commands preloaded 



at startup.    The displayed dialog box shows a list of every command you ran from the command line 
during this session, plus any commands preloaded at startup.    You can submit a command from here by 
clicking on it, or fetch it into the main window for editing.    There's also an Edit Ini File pushbutton. 

SHOW: An Alternative To DIR
SHOW is sometimes more useful than DIR.    Like DIR, you could issue, say, the command SHOW *.WRI 
to display all Windows Write files in a list.    But unlike DIR, SHOW lets you choose one of the files from its 
list.    Click on a filename, then press the OK button, or just double-click on the filename.    Either way, the 
filename you choose is placed on SmilerShell's command line, where it becomes the current in-process 
command.    You can add parameters or edit the command before submitting it.

SHOW works nicely with File Associations.    Because SmilerShell supports File Associations, quite often 
you only have to give the filename, without naming the program to run it.    SmilerShell can often tell what 
program to run, just    by looking at the filename.      So, for example, you could use SHOW to select 
“FILENAME.WRI” into the command line, then just press Enter.    SmilerShell knows to run Windows Write 
on this file.

Command Stack Files
If you have a set of commands you'd like to be able to load into SmilerShell, create a command stack file. 
This is simply an ASCII file with one command per line.    By default, the command stack file name is 
“smishell.stk” and it is in the same directory as the ini file.    However, you can use any name, location, or 
extension you like.

You can load a command stack file automatically when you start SmilerShell by putting the file's name in 
the cmdfile=    line of your ini file.    Alternatively, if you want to pre-load just a few commands when 
SmilerShell starts, you can use the cmdstack= ini file parameter to list the commands right in the 
initialization file itself.

The Initialization File
You can initialize SmilerShell by setting parameters in an initialization file.    This is a plain-text file, so use 
Notepad or another ASCII text editor to edit it.    The file that you need to edit is DRAGFILE.INI and it is in 
your WINDOWS directory.

SmilerShell's initialization file is set up just like every other ini file in Windows.    For each section, there's a 
section header in brackets, under which are entries that are set to values:

[SmilerShell Params]
AliasesCaseSens=TRUE
cmdfile=c:\smipro\smishell.stk
cmdstack=dir \dos;type \autoexec.bat;copy \config.sys junk.tmp;
dirfile=c:\smipro\smishell.dir
DOSinWindow=FALSE
multicmdchar=^
overtype=FALSE
prevdir=<set by SmilerShell when exiting>
restoretime=400
scandrives=bcde
showinactives=TRUE
startupDCscan=TRUE
UseComspec=TRUE
saveparams=FALSE

[SmilerShell Aliases]
TypedAlias=Replacement
word = c:\winword\winword



dirprog=dir c:\mydir\mysubdir\programs\*.exe

You don't have to have all of the parameters.    They don't have to be in the order shown above.    If you 
don't specify a parameter, the internal SmilerShell default (see below) is used for it.    If you do specify 
one, you can comment it out by putting a semicolon at the beginning of its line.

Params:    Most parameters are read at startup and again whenever you Edit Ini File, but some 
parameters are only read at startup (see list).    The defaults, and the parameter meanings, are:

AliasesCaseSens=TRUE
Each command you submit is tested to see if it matches a string on your alias list.    By default, this alias 
testing is case-sensitive.    To change this, set AliasesCaseSens=FALSE.

cmdfile=
File from which to pre-load commands.    By default, no filename specified, so no commands are pre-
loaded.      The cmdstack= setting takes precedence over the cmdfile= setting.    That is, if commands are 
listed in the ini file using the cmdstack= parameter, they will replace any commands read in from a file 
named with the cmdfile= parameter.    This parameter is only read at startup.

cmdstack=
You can list the commands to be pre-loaded at startup right in the ini file.    By default, no commands are 
listed, so no commands are pre-loaded.    Commands to be preloaded are all on one line, separated by 
semicolons (see the example ini file above).    You can have up to 300 characters in this entry.    If you 
need more commands loaded, use a “cmdfile=“ file.    This parameter is only read at startup. 

dirfile=smishell.dir
File from which to load the DC information.    SmilerShell creates this file the first time you use DC (with 
your permission), and whenever you Scan Directories.    The default name is “smishell.dir” and the default 
location is the same directory as the SmilerShell ini file.    Use dirfile= to give it a non-default name or 
location.    A filename without a path is assumed to be in the same directory as the SmilerShell ini file.    
This parameter is only read at startup.

DOSinWindow=TRUE or FALSE; default is what the systemwide “_default.pif” flag is set to.
Do you prefer to run DOS commands fullscreen or in a desktop window?    If you don't specify,    the 
current systemwide value, found in the file “_default.pif” in your Windows directory, is the initial setting.    If 
you have set saveparams to TRUE, indicating that you want SmilerShell to come up next time with the 
same location and status as it ended this time, the DOSinWindow parameter will be updated when    
SmilerShell exits.    This parameter is temporarily toggled when you use the right-bracket command line 
flag.

multicmdchar=^
You can put more than one command on a line.    By default, SmilerShell separates commands with a 
caret [^].    Use this parameter to set the separator character to something else.

overtype=FALSE
By default, SmilerShell's command line starts in insert mode, not overtype mode.    If you have set 
saveparams to TRUE, indicating that you want SmilerShell to come up next time with the same location 
and status as it ended this time, this parameter will be updated when SmilerShell exits.

prevdir=previous drive and directory
You never need to touch this parameter.    If you have set saveparams to TRUE, indicating that you want 
SmilerShell to come up next time with the same location and status as it ended this time, SmilerShell 
creates the prevdir parameter and saves its current directory there at exit.    Next time, SmilerShell starts 
up in this directory.    If you've set saveparams to TRUE but there's no prevdir parameter at startup, 
SmilerShell starts up in the program directory.    This parameter is only read at startup.



restoretime=1000
How many milliseconds to pause before trying to regain the focus from an “[Inactive...” or “Finished” 
window.    Windows needs a little pause here.    How little can your system get away with?    Default is one 
second (1000 milliseconds).

scandrives=c
By default, when you Scan Directories only the C drive is scanned for directory names to be used with 
SmilerShell's DC command.    DC can change to endpoint directories on other drives.    Here is where you 
tell it what drives you want it to be aware of.

showinactives=TRUE or FALSE; default is what the systemwide “_default.pif” flag is set to.
After a DOS command ends, do you want to see the inactive results window or just have it vanish?    If 
you don't specify a preference, the current systemwide value, found in the file “_default.pif” in your 
Windows directory, is the initial setting.    If you have set saveparams to TRUE, indicating that you want 
SmilerShell to come up next time with the same location and status as it ended this time, the 
showinactives parameter will be updated when SmilerShell exits.    This parameter is temporarily toggled 
when you use the asterisk command line flag.

startupDCscan=FALSE
By default, SmilerShell only scans when you use DC’s “/r” flag.      If your system’s directory layout of is 
constantly in flux, you may want to set startupDCscan=TRUE so SmilerShell rescans your DC information 
every time you start.    This parameter is only read at startup.

UseComspec=TRUE
By default, SmilerShell uses the command processor listed in the COMSPEC environment variable.    This 
is usually DOS’s COMMAND.COM, but some people use alternate processors such as 4DOS or NDOS. 
To have SmilerShell explicitly use COMMAND.COM, set UseComspec=FALSE.    This parameter is only 
read at startup.

saveparams=FALSE
Indicates if certain parameters will be saved in the ini file when SmilerShell exits.    If TRUE, then at exit 
the system updates DOSinWindow, overtype, and showinactives, and saves its current directory as the 
prevdir parameter.    If you've set saveparams to TRUE but there's no prevdir parameter at the next 
startup, SmilerShell chooses its own startup directory as if saveparams wasn't specified.

Aliases: You should never need to edit this section by hand.    It's much easier to use the ALIAS and 
UNALIAS commands to set, change, and remove aliases. But just so you know, here's the information.

Aliases are specified one per line in the [SmilerShell Aliases] section, in the form:

alias=replacement

The alias-part is a single word, with no embedded spaces. The replacement-part can be any number of 
words, anything you can type on one line, to the DOS limit of 128 characters per submitted command.    
You can define up to about 100 aliases, depending on their length.

In the replacement-part, the runtime parameters %0 through %9 will be replaced with the matching 
command line arguments. %0 is the alias-part, and %1-9 are the first nine arguments.

The replacement-part can be made up of multiple commands.    They are separated by the multicmdchar 
(^ by default) as on the command line.    Parameters are replaced before the multi-command line is 
broken into individual commands.    Any arguments not used by % parameters are put at the end of the 
multi-command line.

By default, aliases are case-sensitive.    You can change this by setting AliasesCaseSens=FALSE.



Aliases can reference other aliases, but be careful to avoid self-referencing infinite loops (alias 1 defined 
in terms of alias 2 defined in terms of alias 1 ... ). 



Configuring the DOS Command Line
Choose “Options/Settings” and then choose the “DOS Commands” tab and the DOS Command Options 
dialog will appear.

DOS In Window:    You can run most DOS commands with the SmilerShell and can choose to have these 
commands run full screen or in a DOS window.    The default is to run the commands in a DOS Window.
Inactive DOS Windows Stay Visible:    This options determines whether the DOS windows will stay 
around or close after DOS commands are run.    If you choose to have the DOS windows stay around you 
can easily close them all at once by pressing Ctrl+Shift+K from the keyboard.
Insert Mode: Use this to toggle between Insert or Overtype mode
Use Comspec: By default, the DOS command utility, will send all DOS commands to the standard DOS 
command processor, COMMAND.COM.    Some programs like 4DOS, NDOS and others use a different 
command processor.    They specify the command processor in your CONFIG.SYS file with the statement 
"comspec=".    If you choose to have SmilerShell use the command processor specified in your 
CONFIG.SYS file, see that this item is checked.    Inorder to see this option take effect you will have to 
restart Drag And File.    This is only necessary with the Use Comspec option.
Case Sensitive Aliases: SmilerShell's aliases are short commands that are replaced with longer 
commands.    Aliases are like regular commands, just type them in.    An alias can run a single program, or 
be multiple commands on one line, optionally with runtime parameters like batch files. With this option 
checked, you can have the aliases be case sensitive.
Drives to Scan: SmilerShell has a fast directory-change utility called DC.    Just type DC and the first few 
characters of the directory you want to be in, and SmilerShell will takesyou there.    Inorder for DC to work, 
SmilerShell needs to scan your drives to keep a record of the directorys.    Enter the drives that you want 
scanned in this field.

For advanced features of the command line, click here  .  



Accessing the Windows 95 Shell
When running under Windows 95, Drag And File supports the Right Mouse Button Context menus that 
are part of the Windows 95 shell.    For instance you can right click on a group of tagged files and a menu 
will come up allowing you to perform different operations on the files.    There are also contect menus 
available for drive buttons and directories or folders as they are called in Windows 95.



File Context Menu
When you right click on tagged files the context menu options are:
Open    This is the same as launch.    If you have a particular file type Multi-Associated, it will bring up a 
dialog box with programs to launch.    Otherwise it will launch the file with its associated program
Print    This option will only be available if there is a registered file viewer for the file.    If there is, the 
viewer will be launched and it will print the file.
Quick View    This option will only be availabla if there is a registered viewer for the file.    If Drag And View 
is available, it will be launched.    Otherwise.    Windows Quick View will be launched to display the file.
Send To    This option brings up a sub menu from whick you can copy the selected files to floppy diskettes 
or send as a fax or mail
Cut    This option copies the selected files to the clipboard.    The original copies are deleted.    You can 
then bring up the context menu for a directory and choose past to copy the files to that directory.
Copy    This option copies the selected files to the clipboard. You can then bring up the context menu for a 
directory and choose past to copy the files to that directory.
Create Shortcut    This option creates short cuts for the selected files.
Delete    This option deletes the selected files.
Properties    This option brings up the properties dialogs for the selected files.



Directory Context Menu
When you right click on a particular directory the context menu options are:
Explore    This command will open up a copy of Explorer on the highlighted directory.
Open    This option will open an Explorer winodw displaying the contents of the directory.
Find    Opens up the find dialog box from which you can search for files or specific text.
Sharing    If you’re on a network, you can use this option to modify the sharing parameters of the 
directory.
Send To    Sends the contents of the directory to a floppy diskette, fax or mail program.
Copy    Copies the contents of the directory to the clipboard for later pasting.
Paste    If there are files or directories in the clipboard, you can copy them here with this option.
Create Shortcut    Creates a shortcut for the directory.
Properites    Brings up the properties dialog for the directory.



Drive Context Menu
When you right click on a drive button, the context menu options are
Explore    Opens up a copy of Explorer on the drive.
Open    Opens up an Explorer windows on the drive.
Find Opens up the find dialog box from which you can search for files or specific text.
Sharing If you’re on a network, you can use this option to modify the sharing parameters of the drive.
Format    Brings up a dialog box from which you can format the drive
Copy Disk    If you click on a floppy disk, this option will let you perform a disk copy.
Paste    If there are files or directories in the clipboard you can paste them to the rood directory of this 
drive with this option.
Create Shortcut    This option will create a shortcut to this drive.



Right Button Dragging
With Drag And File you can drag files and directories with the right mouse button from Drag And File to 
the desktop and Explorer and from the desktop and Explorer to Drag And File.    When the files are 
dropped a menu will pop up allowing you to perform the following actions.
Move Here    Moves the selected files and directories here
Copy Here    Copies the selected files and directories here
Create Shortcut Here    Creates shortcuts to the selected files and directories in the drop directory.



Copy Diskette

The Copy Diskette command allows you to make an exact copy of any diskette.    Drag And File does disk 
copying in one pass so you don't have to go back and forth between the source and destination disk 
when using the same drive to do the copy.    For best results, use the same size diskette for source and 
destination disks.

Copy Diskette Dialog Box



Label Disk
The Label Disk command allows you to change the volume label of a diskette or local hard drive.    Drag 
And File dilsplays the volume label on the right side of the drive window.

Drag And File Drive Window and Volume Label






